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Preface

Thank you for purchasing the TOSHIBA multifunctional digital system e-STUDIO165/205, 
e-STUDIO167/207/237 or e-STUDIO182/212/242. 
This Network Fax Guide is a manual for the e-STUDIO165/205, e-STUDIO167/207/237 or 
e-STUDIO182/212/242 when the following options are installed:

Network Printer Kit
Fax Kit
External Keyboard

This Network Fax Guide describes how to fax data from your computer using the N/W-Fax 
driver and the AddressBook Viewer.

Be sure to read this manual before using the e-STUDIO165/205, e-STUDIO167/207/237 or 
e-STUDIO182/212/242 with the options above. Keep this manual handy and retain it for future 
reference.
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Software License Agreement

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR 
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE 
LICENSE IS PROVIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE 
SUCH SEPARATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU 
MAY NOT INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE 
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL 
SOFTWARE COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE 
AGREEMENT (“EULA”). INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN 
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED 
HEREWITH; HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CRE-
ATED BY OR FOR TOSHIBA TEC CORPORATION (“TTEC”) ARE PROPRIETARY PROD-
UCTS OF TTEC AND ARE PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL TREATY 
PROVISIONS, AND OTHER APPLICABLE LAWS.

Grant of License
This is a legal agreement between you, the end-user (“You”), and TTEC and its suppliers. This 
software, fonts (including their typefaces) and related documentation (“Software”) is licensed for 
use with the system CPU on which it was installed (“System”) in accordance with the terms con-
tained in this Agreement. This Software is proprietary to TTEC and/or its suppliers.

TTEC and its suppliers disclaim responsibility for the installation and/or use of this Software, and 
for the results obtained by using this Software. You may use one copy of the Software as 
installed on a single System, and may not copy the Software for any reason except as neces-
sary to use the Software on a single System. Any copies of the Software shall be subject to the 
conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse 
compile, reverse assemble, or reverse engineer the Software. You may not use the Software, 
except in accordance with this license. No title to the intellectual property in the Software is 
transferred to you and full ownership is retained by TTEC or its suppliers. Source code of the 
Software is not licensed to you. You will be held legally responsible for any copyright infringe-
ment, unauthorized transfer, reproduction or use of the Software or its documentation.

Term
This license is effective until terminated by TTEC or upon your failure to comply with any term of 
this Agreement. Upon termination, you agree to destroy all copies of the Software and its docu-
mentation.

You may terminate this license at any time by destroying the Software and its documentation 
and all copies.
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Disclaimer of Warranty
THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-
INFRINGEMENT. TTEC AND ITS SUPPLIERS DISCLAIM ANY WARRANTY RELATING TO 
THE QUALITY AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE PROVES 
DEFECTIVE, YOU (AND NOT TTEC OR ITS SUPPLIERS) SHALL BE RESPONSIBLE FOR 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. TTEC 
AND ITS SUPPLIERS DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.

ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY TTEC AND ITS AFFILI-
ATES PURSUANT TO A EULA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED.

Limitation of Liability
IN NO EVENT WILL TTEC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, 
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR 
DEATH RESULTING FROM NEGLIGENCE ON THE PART OF TTEC OR ITS SUPPLIERS), 
INCLUDING WITHOUT LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR 
OTHER INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TTEC OR ITS SUPPLIERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY 
CLAIMS.

U.S. Government Restricted Rights
The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the 
U.S. Government is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the 
Rights in Technical Data and Computer Software Clause set forth in 252.227-7013, or 52.227-19 
(c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is TOSHIBA TEC Corporation, 
2-17-2, Higashigotanda, Shinagawa-ku, Tokyo, 141-8664, Japan.

General
You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt 
to sublicense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is 
void. You agree that you do not intend to, and will not ship, transmit (directly or indirectly) the 
Software, including any copies of the Software, or any technical data contained in the Software 
or its media, or any direct product thereof, to any country or destination prohibited by the United 
States Government. This license shall be governed by the laws of Japan or, at the election of a 
Supplier of TTEC concerned with a dispute arising from or relating to this Agreement, the laws of 
the Country designated from time to time by the relevant Supplier of TTEC. If any provision or 
portion of this Agreement shall be found to be illegal, invalid or unenforceable, the remaining 
provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT 
YOU UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE 
COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLI-
ERS AND SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, 
OR ANY OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS 
LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 2-17-2, Higashigotanda, Shinagawa-ku, Tokyo, 141-8664, Japan.
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Before Reading This Manual

Lineup of our manuals
These manuals are provided for the operation of the e-STUDIO165/205, e-STUDIO167/207/237 
or e-STUDIO182/212/242. Select and read the manual best suited to your needs. This manual is 
the Network Fax Guide.

Basic functions

Facsimile functions

The Fax Kit GD-1221 (optional) is necessary for using the Fax functions.

Printing functions

The Network Printer Kit GA-1191 (optional) is necessary for using the printing functions.

Operator’s Manual for Copying Functions (Booklet)
This manual describes the basic operations, mainly copying functions, of this equipment. It 
also describes safety precautions to ensure correct and safe use of this equipment. Be sure to 
read this before you use the equipment.

Operator’s Manual for Facsimile Function (Booklet)
This manual describes how to use the Fax functions. Various functions both basic and 
advanced regarding Fax transmission/reception are available.

Quick Start Guide for Printing Functions (Booklet)
This manual gives basic information regarding the printing functions, such as the GA-1191 
accessories, necessary environmental conditions and outline of network connections as well 
as troubleshooting. Be sure to read this before using the printing functions.

Network Administration Guide for Printing Functions (PDF file)
This manual describes the operation necessary for configuring a network and using the print-
ing functions, such as connecting to a network and setting components.

Setup Guide for Printing Functions (PDF file)
This manual consists of the following two parts.
Control panel: This part describes how to configure the printer-related settings using the 

control panel of the equipment.
TopAccess: This part describes how to use the co-packed utility “TopAccess”. The set-

tings and management of the equipment can be done using a Web browser.

Printing Guide (PDF file)
This manual describes the operation necessary for printing data from a computer, such as the 
installation of the client software and the use of the printer driver.

Network Fax Guide (PDF file, This manual)
This manual describes the operation necessary for sending a Fax from a computer via a net-
work, such as the installation of the client software, use of the N/W-Fax driver and the co-
packed application software “AddressBook Viewer”.
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Scanning functions

The Scanner Upgrade Kit GA-1201 (optional) is necessary for using the scanning functions.

To read manuals in the PDF file format
The operator's manual in the PDF (Portable Document Format) can be displayed/printed using 
Adobe Reader or Adobe Acrobat Reader. If neither is installed in your computer, download one 
of them. This can be done via the website of Adobe Systems Incorporated.

Quick Start Guide for Scanning Functions (PDF file)
This manual gives the basic information regarding the scanning functions, such as the 
GA-1201 accessories, necessary environmental conditions and outline of network connec-
tions as well as troubleshooting. Be sure to read this before using the scanning functions.

Network Administration Guide for Scanning Functions (PDF file)
This manual describes the operation necessary for configuring a network and using the scan-
ning functions, such as connecting to a network and setting components.

Setup Guide for Scanning Functions (PDF file)
This manual consists of the following two parts.
Control panel: This part describes how to configure the scanner-related settings using the 

control panel of the equipment.
TopAccess: This part describes how to use the co-packed utility “TopAccess”. The set-

tings and management of the equipment can be done using a Web browser.

Scanning Guide (PDF file)
This manual describes the operation necessary for using the scanning functions, such as the 
installation and the use of the TWAIN driver.
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How to read this manual

Symbols in this manual 
In this manual, some important items are descried with the symbols shown below. Be sure to 
read these items before using this equipment.

Trademarks
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating 
System.
The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating 
System.
Microsoft, Windows, Windows NT, and the brand names and product names of other 
Microsoft products are trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple 
Inc. in the US and other countries.
PostScript is a trademark of Adobe Systems Incorporated.
Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Founda-
tion in the U.S. and other countries.
Netscape is a trademark of Netscape Communications Corporation.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respec-
tive companies.

©2009 TOSHIBA TEC CORPORATION All rights reserved
This manual is protected by copyright laws. No part of this manual shall be duplicated or repro-
duced without the permission of TOSHIBA TEC CORPORATION. TOSHIBA TEC CORPORA-
TION shall not be liable in terms of granting patents for any use of information contained in this 
manual by third parties.

Indicates information to which you should pay attention when operating the 
equipment.

Describes handy information that is useful to know when operating the equip-
ment.

Pages describing items related to what you are currently doing. See these 
pages as required. 
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Features and Functions

The network fax functions of this equipment allow you to make direct fax transmission of elec-
tronic documents from your computer. The fax documents are transmitted from the computer to 
this equipment through a network, and then this equipment transmits them to outside fax 
machines through public switched telephone networks.
The N/W-Fax driver is complimented with the AddressBook Viewer. The combination of applica-
tions enables you to easily manage a selection of fax recipients and access to the address book.

When you fax hard copies, not electronic documents, fax them using the control panel of this 
equipment.
Fax transmission using the N/W-Fax driver is available only when both the Network Printer 
Kit (optional), the Fax Kit (optional) and the External Keyboard (optional) are installed.

Features

N/W-Fax driver
When the N/W-Fax driver is installed, you can transmit electronic documents as fax data 
from your computer to several destinations.
When you fax documents, you can easily set the list for the destinations or the resolution of 
the fax data. 
When you fax documents, you can attach an embedded cover sheet on them. Information 
about the fax documents and their detailed messages can be included in this cover sheet. 
The destinations of the fax can be entered manually, or can be selected from the address 
book data by running the AddressBook Viewer. In this method, you can easily search for the 
desired addresses throughout the address book. 
Since the image data processing methods for network fax documents and regular fax docu-
ments differ, the image quality for network fax documents may vary compared with that for 
regular fax documents.

AddressBook Viewer
The data of the various address books including the one for this equipment can be managed. 
The address book data of the other devices can be converted into a format which is retriev-
able in this equipment. 
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Functions 
The general descriptions of the N/W-Fax driver and the AddressBook Viewer are shown below. 

N/W-Fax driver
The N/W-Fax driver allows you to make fax transmission of documents created in your com-
puter. In a normal procedure, select the [Print] menu in the application in which the documents 
were created, select this driver (TOSHIBA e-STUDIO205 Series Fax), and then start printing. 
The documents are then transmitted to this equipment. This equipment then transmits the docu-
ments to outside fax machines through public switched telephone networks, using the Fax Kit 
(optional) and the External Keyboard (optional).
In fax transmission using the N/W-Fax driver, you can enter the destination of the fax manually 
or retrieve the desired destinations from the address book data of the AddressBook Viewer.

AddressBook Viewer
The AddressBook Viewer is the managing software for address books. With the AddressBook 
Viewer, you can use the local address book of your computer or the LDAP address book of an 
LDAP server. Also the address books of this equipment and those of other compatible TOSHIBA 
equipment can be used as a public address book. The AddressBook Viewer also allows you to 
add or edit the destinations in the address books by the recipient or the group.
The address book data conversion function of the AddressBook Viewer allows you to import and 
export address book data in a CSV/vCard format so that the created address book data can be 
shared effectively. 

G3 Facsimile

PSTN

Client computer

Applications

Document

Document data

Network

N/W-Fax Driver
(Transmits document data as a fax)

AddressBook Viewer
(Manages address books)

Address book data

Local address book

LDAP address book

Public address book,etc.

Destination searching
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This section describes the instructions on how to install the client software for the network fax features.
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Installing the N/W-Fax driver and AddressBook Viewer....................................................................15
Uninstalling the N/W-Fax driver and AddressBook Viewer ...............................................................26
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Installing Network Fax Software

This chapter describes how to install the software required for fax transmission from this equip-
ment and for using various address books. It is recommended that you read this chapter in its 
entirety before the installation.

Overview
Before you can begin utilizing the network fax feature for this equipment, you must install the 
software using the Client Utilities CD-ROM provided. You will use the InstallShield client soft-
ware setup process. This section describes the way to add N/W-Fax driver and AddressBook 
Viewer to user’s computers. 

System requirements
The N/W-Fax driver and AddressBook Viewer are available for the following environments:

Display resolution
1024 x 768 dots or more
Display color
High Color (16bit) or higher is recommended.
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 1 / Service Pack 2 / Service Pack 3
Windows Vista Service Pack 1 / Service Pack 2
Windows Server 2003 Service Pack 1 or later
Windows Server 2008 Service Pack 1 or later

Before proceeding to this section, you must logon Windows with a user account that allows 
you to install or uninstall client software (e.g. administrator privilege). If you are using Win-
dows Vista or Windows Server 2008, you can temporarily change your user account to the 
one noted above with its User Account Control function. Ask your administrator for the 
details.
When you want to send a fax using the N/W-Fax driver from Windows 98/Windows Me/Win-
dows NT using e-STUDIO165/205 or e-STUDIO167/207/237, contact your service techni-
cian or representative.
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Before installing client software
Before installing the client software, confirm the following to perform an appropriate installation.

When the AddressBook Viewer has already been installed:
The AddressBook Viewer cannot be double-installed or overwritten. If it is installed from other 
Client Utilities CD-ROMs or similar, uninstall it and then install it again according to the following 
procedure in order to use the latest one. The AddressBook Viewer included in this equipment 
(e-STUDIO165/205, e-STUDIO167/207/237 or e-STUDIO182/212/242) can be used with the 
e-STUDIO850 Series, e-STUDIO282 Series, e-STUDIO452 Series, e-STUDIO451C Series, 
e-STUDIO3510C Series, e-STUDIO4520C Series, e-STUDIO6530C Series, e-STUDIO455 
Series and e-STUDIO855 Series.
In addition, when uninstalling the current AddressBook Viewer, a dialog box which prompts you 
to check the setting files deletion is displayed. Click [No] in the dialog box to leave the setting 
files so that they can be used in the AddressBook Viewer to be newly installed.
 
When the AddressBook Viewer has not been installed:
There is no necessary operation in advance. Perform installation according to the following pro-
cedure.

Installing the N/W-Fax driver and AddressBook Viewer
You can install the N/W-Fax driver and AddressBook Viewer from the Client Utilities CD-ROM.
This section describes about installing the N/W-Fax driver and AddressBook Viewer in a Raw 
TCP environment.

Installing from Client Utilities CD-ROM
This section describes how to install fax client software under Raw TCP environments through 
TCP/IP, using an installer.
The N/W-Fax driver can be set up using the same connection as a printer driver such as, LPR 
printing, IPP printing, and Novell printing. To set up the N/W-Fax driver using these connections, 
please refer to the Printing Guide.

Installing the fax client software for Raw TCP connection using the installer

The procedure presented here describes the installation to Windows 2000 using the installer. 
The procedure is the same when other versions of Windows are used. (The N/W-Fax driver can 
also be installed using the Add Printer wizard. Please see the Printing Guide.)

Before installing the printer driver in a Raw TCP environment, confirm the following:
This equipment is connected to the network and turned on.
The TCP/IP setting is correct on this equipment and your computer.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
The installer automatically starts and the Choose Setup Language dialog box 
appears.
When the installer does not automatically start, double-click “Setup.exe” in the Client 
Utilities CD-ROM.
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2 Select your language and click [OK].

The Welcome to the InstallShield wizard screen is displayed.

3 Click [Next].

The License Agreement screen is displayed.

4 Please read the license agreement carefully and click [Yes].

The Choose Destination Location screen is displayed.
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5 Click [Next].

If you want to change where the programs are installed, click [Browse]. In the dialog box 
appears, select the folder and click [OK].

The Setup Type screen is displayed.

6 Select “Custom” and click [Next].

The Select Components screen is displayed.
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7 Check the software that you want to install and click [Next].

Toshiba e-STUDIO205 Series N/W-Fax:Check this to install the N/W-Fax driver.
Toshiba e-STUDIO AddressBook Viewer:Check this to install the AddressBook 
Viewer.

The Select Port screen is displayed.

The names of other printing software, besides the above two, are displayed in the Select 
Components dialog box. (You can install them as required.)

8 Since the installer detects this equipment and the name of this 
equipment is displayed at “Devices on Network”, select it and then 
click [Next].

The Select Program Folder screen is displayed.
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If this equipment is not properly connected in your network, the message that the installer 
cannot discover this equipment is displayed. Click [Retry] to search again. Click [Con-
tinue] to configure a local port.

Select “Local Port” to configure a local port, and then select in the drop down box the 
desired port configured previously. If a local port is not configured previously, select any 
port in the drop down box as a temporary port so that you can continue the installation. 
Then click [Next].

If you selected a temporary port in the step above, you need to configure a correct port 
after installation. See “Note” in step 11.

9 Click [Next].

If you want to change the program folder, rename the folder in the “Program Folder” field. 

The Start Copying Files screen is displayed. 
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10 Click [Next].

Starts copying files and the InstallShield Wizard Complete screen appears when this is 
completed.

When you select to install the N/W-Fax driver, the Digital Signature Not Found dialog box 
is displayed while files are being copied. Click [Yes] to continue the installation.

11 Click [Finish].

The installation is completed.
The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart 
my computer now.” and click [Finish] to restart your computer.

If you selected a temporary port in the Select Port screen in step 7, configure TCP/LPR 
port referring the following page:

 P.21 “Configuring the Raw TCP/LPR port”
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Configuring the Raw TCP/LPR port

The procedure above is only for the case you select a temporary port. If you do not select a tem-
porary port, the procedure is not necessary.

1 Click [Start], select [Settings], and click [Printers] to open the Print-
ers folder.

If you are using the Windows XP or Windows Server 2003, click [Start] and [Printers 
and Faxes] to open the Printers and Faxes folder.
If you are using the Windows Vista or Windows Server 2008, click [Start], select [Con-
trol Panel], and click [Printers] under [Hardware and Sound] to open the Printers 
folder.

2 Select the Fax driver and select [Properties] in the [File] menu.

When using Windows Vista or Windows Server 2008, click the [Properties] in the 
Organize tab.
The printer driver properties dialog box appears.
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3 Display the [Ports] tab and click [Add Port].

The Printer Ports dialog box appears.

4 Select “Standard TCP/IP Port” and click [New Port...].

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

5 Click [Next].
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6 Enter the IP address of this equipment in the “Printer Name or IP 
Address” field and click [Next].

If your network uses a DNS or WINS server, enter the printer name of this equipment 
provided from DNS or WINS in the “Printer Name or IP Address” field.
In the “Port Name” field, the port name is automatically entered according to the IP 
address or DNS name entered in the “Printer Name or IP Address” field.
The very first “IP_” is not displayed on Windows Vista or Windows Server 2008.

7 Select “Standard” and click [Next].

If you are using Windows Vista or Windows Server 2008, the above screen is not 
displayed.
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When the LPD Print setting is enabled, you can also configure LPR printing. When you want to 
configure LPR printing, follow the procedure below.
If you are using Windows Vista or Windows Server 2008, right-click on the printer driver in the 
Printers folder, select [Properties] and set the port with [Configure Port..] in the [Port] tab page.

Select “Custom” and click [Settings].

Select “LPR” at the “Protocol” option, enter “Print” in the “Queue Name” field at the 
“LPR Settings” option, and then click [OK].

Click [Next].
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8 Click [Finish].

The screen returns to the Printer Ports dialog box.

9 Click [Close] to close the Printer Ports dialog box.

10 Make sure the created Raw TCP or LPR port is checked in the “Print 
to the following port(s)” list and click [Close].
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Uninstalling the N/W-Fax driver and AddressBook Viewer
The following instructions describe how to uninstall the N/W-Fax driver and AddressBook 
Viewer. The uninstallation procedure is different depending upon how you installed the client 
software.

Uninstallation of the N/W-Fax driver and AddressBook Viewer
 P.26 “When installed using the installer”

Uninstallation of the N/W-Fax driver 
 P.30 “When installed using Add Printer Wizard”

When installed using the installer
When the client software was installed using the Installer in the Client Utilities CD-ROM, you can 
delete all files using the Add/Remove Programs function.
You can uninstall all client software that have installed from the Client Utilities CD-ROM, or you 
can uninstall only the N/W-Fax driver and AddressBook Viewer.

 P.26 “Uninstalling the all client utilities software”
 P.28 “Uninstalling only Network Fax Diver and AddressBook Viewer”

Uninstalling the all client utilities software

The following describes an uninstallation on Windows 2000. The procedure is the same when 
other versions of Windows are used.

1 Open “Control Panel” and double-click the “Add/Remove Pro-
grams” icon.

The Add/Remove Programs dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Client” and click [Change] or 
[Remove].

The InstallShield Wizard dialog box appears.

3 Select “Remove” and click [Next].

The Confirm Uninstall dialog box appears.

4 Click [OK].

5 Click [Yes] to delete the setting files.

Deleting files starts.

If you want to re-install the client software later, click [No] to remain the setting files. You 
can restore the data and settings when you re-install the client software.
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6 Select “Yes, I want to restart my computer now.” and click [Finish] 
to restart your computer.

Some files may be deleted after restarting the computer.

Uninstalling only Network Fax Diver and AddressBook Viewer

The following describes an uninstallation on Windows 2000. The procedure is the same when 
other versions of Windows are used.

1 Open “Control Panel” and double-click the “Add/Remove Pro-
grams” icon.

The Add/Remove Programs dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Client” and click [Change] or 
[Remove].

The InstallShield Wizard dialog box appears.

3 Select “Modify” and click [Next].

4 Uncheck the components that you want to uninstall and click 
[Next].

Deleting files starts.
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5 Click [Yes] to delete the setting files.

Deleting files starts.

If you want to re-install the client software later, click [No] to remain the setting files. You 
can restore the data and settings when you re-install the client software.

6 Select “Yes, I want to restart my computer now.” and click [Finish] 
to restart your computer.

When installed using Add Printer Wizard
When only N/W-Fax driver is installed by Add Printer Wizard, you can uninstall them by deleting 
the printer icons in the Printers folder.

Deleting the N/W-Fax driver

1 Open “Printers” folder, select the printer icon that you want to 
delete, and press the [Delete] key.

When using Windows Vista or Windows Server 2008, select the printer icon that you 
want to delete, and click the [Delete] in the Organize tab.
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2 Click the [File] menu and select [Server Properties].

The Print Server Properties dialog box appears.
When you are using Windows Vista or Windows Server 2008, follow the procedure 
below:
- Right-click in the blank area in the “Printers” window and click [Run as administra-

tor] and then [Server Properties] in the menu displayed.
- When “Windows needs your permission to continue” appears, click [Continue].

3 Display the Drivers tab. Select the N/W-Fax driver and click 
[Remove].

The confirmation dialog box appears.
When you are using Windows Vista or Windows Server 2008, follow the procedure 
below after selecting [Remove]:
- Select “Remove driver and driver package” and click [OK] in the “Remove Driver 

And Package” dialog box.
- Click [Yes] in the “Print Server Properties” dialog box.
- When “Driver package information collected” appears, click [Delete].
- When “Driver package was removed” appears, click [OK].
- This is the end of the procedure for Windows Vista or Windows Server 2008.

4 Click [OK].

The N/W-Fax driver is completely deleted.
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Faxing from Applications

The N/W-Fax driver allows you to fax document data from your computer to several destina-
tions. It also enables the setup of the fax properties and editing of the sender’s information.

Check if all the fax settings of this equipment have been done prior to fax transmission.
Fax functions using the N/W-Fax driver are available only when both the Network Printer Kit 
(optional), the Fax Kit (optional) and the External Keyboard (optional) are installed.

How to fax using the N/W-Fax driver
Follow the procedure below to fax document data from your computer with the N/W-Fax driver 
installed.

Create a document.
Print to Fax Driver.
Add recipient’s name and fax numbers.
Select a default cover page (optional).
Send the fax.

The maximum number of pages to fax a document using the N/W-Fax driver is 1000.

Preparing documents for faxing
To see how objects, such as headers, footers, or drawing objects, will be positioned on a fax 
page, switch to your applications’ page layout view. If the software application you are using pro-
vides a Print Preview option, you can use it to view your fax before it is sent.

Faxing from Windows applications
Once you have installed the N/W-Fax driver, you can send the document directly from most Win-
dows applications as a fax.
You can print using various functions by setting print options on the printer driver.

Faxing from Windows applications

1 Open a file and select [Print] from the [File] menu of the application.
The Print dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Fax” and Click [Properties].

The properties dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different 
depending on the application you are using. See your application’s manual about dis-
playing the printer properties dialog box.

3 Display the Send tab and specify the recipients, and other options.

 P.37 “Specifying recipients”
 P.48 “Setting the send properties”
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4 Display the Cover Sheet tab and specify the cover sheet properties 
if you want to send a document with a fax cover sheet.

 P.50 “Setting up the cover sheet properties”

5 If you want to add sender information on a fax cover sheet, check 
the Sender Information check box. Then click the Sender Informa-
tion tab and then enter the sender information message you want to 
add on the fax cover sheet.

 P.51 “Setting up the sender information properties”

6 Click [OK] to save the settings.

7 Click [OK] or [Print] to send a document.

When the department management is enabled, if network fax transmission is performed 
with an incorrect department code, a dialog box indicating that it is incorrect appears. In 
this case, enter the correct one or stop transmitting. If this dialog box does not appear, 
the job becomes invalid and is deleted. An error report is then printed out from this equip-
ment.
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Specifying recipients
You can specify the recipients following method:

 P.37 “Specifying recipients from address book”
 P.39 “Entering a recipient manually”

Also you can remove the recipients added to the “To” list.
 P.40 “Removing recipients from the “To” list”

You can specify up to 100 recipients.

Specifying recipients from address book

1 Click [Select From Address Book] in the Send tab.

The AddressBook Viewer is launched.

To utilize the address book, you must register contact information into the address book 
in advance. For this registration, see the following page:

 P.65 “Managing Address Book”
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2 After selecting a contact from the contact list, click [Select Fax].

The selected recipients are listed in the “Selected Fax” or “Selected Email”.

You cannot specify Email addresses for destinations because [Select Email] is not avail-
able for this equipment.

For details on the AddressBook Viewer, refer to the following chapter:
 P.55 “USING ADDRESS BOOK”

You can select a recipient by the following operations:

Selecting a contact by dragging and dropping
Drag a contact in the contact list and drop it to the “Selected Fax”.

Selecting a contact by double-clicking on it
Double-click on a contact in the contact list to include the contact in the “Selected Fax”. 

Selecting a contact from a shortcut menu
Right-click on the contact in the contact list, select [Select] from the shortcut menu and 
then [Fax Number].

Removing a recipient
Select a recipient in the “Selected Fax” and click [Remove] (Left: fax number).
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3 Click [OK].

The AddressBook Viewer is closed and the recipients selected for “To” are listed.

When the fax transmission is completed, the recipients are automatically removed from 
the “To” list.

Entering a recipient manually

1 Click [New].

The Direct Dial dialog box appears.
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2 Enter the fax number in the right field. In addition, if you specify a 
Sub address, enter the Sub address in the “SUB” field, and security 
password for the Sub address in the “PWD” field if required.

If you specify a Sub address complying with ITU-T F-code communications, you can for-
ward fax data to any fax machine regardless of its manufacturer or the model. In this 
case, however, the recipient’s fax machine also must support ITU-T F-code functions.

3 Click [OK].
Entered recipient is added to the “To” list.

It is automatically deleted from the “To” list when the transmission is completed.

Removing recipients from the “To” list

1 Select a recipient that you want to delete from the “To” list.

2 Click [Remove].
The selected recipient is deleted from the “To” list.
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Searching the address book for contacts
In order to quickly locate contacts you can search the address book database. You simply type 
in a string or letters to be used to search the database. The AddressBook Viewer will search for 
any entry that contains the specified string.
You can search contacts by the name and fax number. Also you can search contacts by specify-
ing the detailed search conditions.

1 Click [Select From Address Book] in the Send tab.

The AddressBook Viewer is launched.

2 Select [Find] from the [Edit] menu.

The [Find Contact] dialog box appears.
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3 Select an address book to search in the [Data Source] drop down 
box.

To change the setting of the default address book in the [Data Source] drop down box, 
select [View] - [Default Configuration] - [Data Source] and then choose an address book.
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4 Display the [Person] tab and enter search strings in the following 
fields.

Display Name — To search display names, enter a search string here.
Fax Number — To search fax numbers, enter the numbers here.
Email — To search Email address, enter a search string here.

If you perform searching in the above conditions, proceed to step 5. If you want to set 
more detailed search conditions, proceed to step 4 and set the [Detail Setting] tab. Note 
that even if you enter the search conditions in both the [Person] and [Details] tabs, you 
cannot perform searching in these combined conditions.

In the [Person] tab, you do not have to fill in all the fields and the string does not need to 
completely correspond to the target of the search. Entering one or more characters in 
one or more fields causes a search to be made for contacts which correspond to the par-
ticular conditions.
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5 Display the [Detail Setting] tab, set the search condition, and then 
click [Add].

Field Select — Select an item to be searched.
Condition of search string — Select a condition in the left-hand drop down box, and 
then enter a search string in the right-hand field.

The search condition is displayed in the “Condition list”.
To set more than one search condition, repeat this operation as many times as 
needed.
To delete the search conditions, select one and click [Delete].
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6 Click [Search].

It starts searching contacts in the selected address book. When the search is com-
plete, the contacts matching the search conditions are listed.
To stop searching, click [Stop].

Even if you enter the search conditions in both the [Person] and [Details] tabs, only the 
search condition in the tab currently displayed is used. You cannot perform searching in 
the combined conditions on both tabs.
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7 Drag and drop the contacts to “Selected Fax” from the list of the 
search results.

The selected recipients are listed in the “Selected Fax”.

You cannot specify E-mail addresses for destinations.

You can select a recipient by the following operations:

Selecting a contact by double-clicking on it
Double-click on a contact in the list of the search results to include the contact to the 
“Selected Fax”.

Selecting a contact from a shortcut menu
Right-click on the contact in the list of the search results, select [Select] from the shortcut 
menu and then [Fax Number].

Removing a recipient
Select a recipient in the “Selected Fax” and click [Remove] (Left: fax number).
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8 Click [OK].

The AddressBook Viewer is closed and the recipients selected for “To” are displayed on 
the list.

When the fax transmission is completed, the recipients are automatically removed from 
the “To” list.



3 FAXING FROM CLIENT COMPUTERS

48    Faxing from Applications

Setting up the network fax options
Network fax options are the attributes you set to define the way a fax job is transmitted. For 
example, you can specify the recipients, resolution, and paper size.

You can send a fax with a cover sheet. See the following for details.
 P.52 “Sending with extended fax functionality”

Setting the send properties
In the Send tab of the network fax properties dialog box, you can specify the recipients and how 
the fax will be sent.

To specify the recipients, you can select from the address book or enter the recipient manually.
 P.37 “Specifying recipients”

1) To
This displays the specified recipients list.

2) [Select From Address Book]
Click to launch the AddressBook Viewer. You can select recipients from the address book.

 P.37 “Specifying recipients from address book”

3) [New]
Click to add new recipient by entering manually. The Direct Dial dialog box appears.

 P.39 “Entering a recipient manually”

4) [Remove]
Select a recipient in the “To” list and click this to remove the recipient from the list.
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5) Resolution
Select the resolution for the fax.
- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x 

100 dpi).
- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200 

x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x 

400 dpi).

6) Dept. Code
Enter 5-digit department code if required. When the department code is enabled on this 
equipment, you must enter the department code to send a fax.

If network fax transmission is performed with an incorrect department code, a dialog box 
indicating that it is incorrect appears. In this case, enter the correct one or stop transmitting. 
If this dialog box does not appear, the job becomes invalid and is deleted. An error report is 
then printed out from this equipment.

7) Paper Size
Select the paper size of your document.

8) Orientation
Select the orientation of your document.
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Setting up the cover sheet properties
In the Cover Sheet tab of the network fax properties dialog box, you can specify the fax cover 
sheet to be sent. If you enable the cover sheet, the cover sheet is attached in the first page of 
the document and sent to the recipients.

1) Cover Sheet
Select the cover sheet type from “Standard Cover Page”, “Business Cover Page”, and “Pro-
fessional Cover Page”. For cover sheet samples, see the following page:

 P.112 “Cover Sheet Samples”

2) Font Name
Select the font to be used for the cover sheet.

3) Subject
Enter the subject to appear on the cover sheet. You can enter up to 40 characters.

4) Message
Enter the message to appear on the cover sheet. You can enter up to 500 characters.

5) Sender Information
Check this to print sender information on the cover sheet. When this is enabled, specify the 
sender information in the Sender Information tab.

 P.51 “Setting up the sender information properties”

6) Recipient Information
Check this to have recipient information appear on the cover sheet. Select one or more of 
the following options to determine what information will appear in the “To:” field of the cover 
sheet.
- Name — Check this to have the recipient name appear on the cover sheet.
- Company — Check this to have the recipient company name appear on the cover sheet.
- Department Name — Check this to have the recipient department name appear on the 

cover sheet.
- Fax Number — Check this to have the recipient fax number appear on the cover sheet.

7) Reference Number
Enter the reference number to identify the fax. This number will appear on the cover sheet.
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Setting up the sender information properties
In the Sender Information tab of the network fax properties dialog box, you can specify the 
sender information that appears on the cover sheet. This must be set only when the “Sender 
Information” box in the Cover Sheet tab is checked.
In the text field in the Sender Information tab, you can enter the up to 500 characters.

Displaying the version information
In the About tab of the network fax properties dialog box, you can display the version information 
of the N/W-Fax driver.
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Sending with extended fax functionality
The N/W-Fax driver allows users to perform the following features:

 P.52 “Sending with a cover sheet”

Sending with a cover sheet
You can choose to send a cover sheet with your fax transmission. The cover sheet is merged 
with the recipient “To” list data to create a fax cover sheet. You can select what to include on the 
cover sheet such as sender or recipient information.

Preparing the cover sheet

1 Display the Cover Sheet tab and select the cover sheet type in the 
“Cover Sheet” drop down box.

For samples of the cover sheets, see the Appendix at the end of this guide.
 P.112 “Cover Sheet Samples”

2 Select the font in the “Font Name” drop down box.

The selected font applies to the text contents in the cover sheet.

3 Enter the subject to appear on the cover sheet in the “Subject” 
field.

You can enter up to 40 characters for the subject.

4 Enter the message to appear on the cover sheet in the “Message” 
field.

You can enter up to 500 characters for the message.
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5 If you want the sender information to appear on the cover sheet, 
check the “Sender Information” box.

If you check this, click the Sender Information tab and enter the sender information in the 
text box. You can enter up to 500 characters in the sender information text box.

6 If you want the recipients information to appear on the cover sheet, 
check the “Recipients Information” box and check the items 
required for the recipient information.

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on the cover 
sheet.
Department Name — Check this to have the department name of the recipient appear 
on the cover sheet.
Fax Number — Check this to have the fax number of the recipient appear on the cover 
sheet.

Recipients information is obtained from the address book. (The data input on page  
P.69 “Configuring the connection manually and obtaining the address book data” are 
used.) If the recipient is added manually, this information does not appear on the 
cover sheet except for the fax number.
The recipients information for all recipients will appear on the cover sheet.

7 If you want the reference number to identify the document to 
appear on the cover sheet, check the “Reference Number” box and 
enter the reference number in the field.

You can enter up to 20 characters for the reference number.

8 Specify the other options to send a document and click [OK].

9 Click [Print] to send a document to this equipment.
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Running AddressBook Viewer

The AddressBook Viewer allows you to manage the address book properties, manage address 
books and address book entries. Particularly, you can perform the following functions:
Managing the private address book:

Create new contacts
Create address book groups
Modify contact information
Search the address book database
Import address book data
Export address book data
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Running the AddressBook Viewer
You can access the AddressBook Viewer using two methods:

Programs folder in the Start menu
Print Properties window of the N/W-Fax driver (limited accessibility)

Access using program group
From the Program Group, you can access the AddressBook Viewer to create and edit your pri-
vate address book.

Accessing the AddressBook Viewer from the programs group

1 Click the [Start] menu, select [Programs], [TOSHIBA e-STUDIO Cli-
ent], and select [TOSHIBA e-STUDIO AddressBook Viewer].

The AddressBook Viewer window appears.

When a telephone number with a PIN code (charge code) is registered on an abbrevi-
ated number or a one touch dial number from this equipment, the PIN code is displayed 
in “$”. On the AddressBook Viewer screens the PIN code is displayed as it is.
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Access using print properties
Within the application Print window, you have a limited ability to create and edit contacts in the 
Address Book.

This method is only suggested if you are in the process of sending a fax and you need to add a 
fax recipient to the send list that is not currently a member of the Address Book. Otherwise, use 
the program group to access the AddressBook Viewer.

Accessing the AddressBook Viewer from the print properties

1 In the Print dialog box in the application, select “TOSHIBA 
e-STUDIO205 Series Fax” for the printer and click [Properties].

The Network Fax properties dialog box appears.

2 Click [Select From Address Book] in the Send tab.

The AddressBook Viewer window appears.
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— Selecting contacts for network fax
When you access the AddressBook Viewer from the N/W-Fax driver, it allows you to select the 
contacts from the AddressBook Viewer.
However, if you access the AddressBook Viewer from the Start menu, recipients cannot be 
selected.
To select contacts from the AddressBook Viewer, refer to the following page:

 P.37 “Specifying recipients”

To select recipients by searching the address books for contacts, refer to the following page:
 P.41 “Searching the address book for contacts”

For details on the N/W-Fax driver, refer to the following page:
 P.34 “Faxing from Applications”
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About AddressBook Viewer interface
The AddressBook Viewer main window consists of the following items:

When the AddressBook Viewer is run from the start menu

When the AddressBook Viewer is run from a N/W-Fax driver

1) Menu Bar
You can perform various functions by selecting a command from the menus.

 P.61 “Menu bar”

2) Toolbar
You can perform general functions quickly by clicking an icon in the tool bar.

 P.63 “Toolbar”

3) Browse Pane
You can expand or collapse to view/hide Groups and Contact address book entries.
The browse pane contains a tree structure for the following address books:
- Private Address Book — This contains the contacts registered in the associated client 

address book on your client computer.
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- Public Address Book — This contains the contacts registered in the address book in 
this equipment.

- MAPI Address Book — This contains the contacts in the address book of default mail 
client in your computer.

- MS Outlook Express — This contains the contacts in the MS Outlook Express address 
book in your client computer. The name of this address book may differ depending on the 
Email software of Microsoft in your computer.

- LDAP Address Book — This contains the contacts in specified LDAP server.
- Import Address Book — If the address book data have been imported from a CSV file 

or vCard file, this address book will be displayed.

4) Contents Pane
The right-hand pane displays non-modifiable, text-only summary information about the cur-
rently selected address book entry. Selecting an entry in the browse pane of the address 
book displays summary information about the entry in the contents pane. 

5) Status Bar
This displays the description of selected command in the left side, and the number of the 
items of the currently selected address book entry in the right side.

6) Recipient selection tools
When the AddressBook Viewer is run from a N/W-Fax driver, you can select a Network Fax 
or Internet Fax recipient using these tools.

 P.37 “Specifying recipients”

Using commands
AddressBook Viewer allows you to perform a wide variety of functions.
You can access all of the commands from menus in the menu bar and from the icons in the tool 
bar at the top of the AddressBook Viewer window. You can also choose commands from con-
text-sensitive menus by right-clicking the browse pane and contents pane.

Menu bar
The menu bar contains five menus of commands that allow you to perform various functions in 
AddressBook Viewer.

1) File menu
The following commands can be selected in the File menu.
- New Contact — Select this to add new contact in the private address book. If the cur-

rently selected item is a group, the contact will be created as a member of the group. If 
the currently selected item is the “Location/People” folder or “Private Address Book” 
object, the contact will be created in the "Location/People" folder. This command is avail-
able only when selecting items in the object in the private address book.

- New Group — Select this to add new group in the private address book. This command 
is available only when selecting the “Private Address Book” or “Group” folder in the “Pri-
vate Address Book”.

- Properties — Select this to edit or display the properties of a group or a contact in the 
private or public address book. This command is available only when selecting a group 
or a contact in the private or public address book.

- Delete — Select this to delete a group or contacts in the private address book. This com-
mand is available only when selecting a group or contacts in the private address book.

- Devices — Select this to download the public address book from this equipment.
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- Import -CSV File — Select this to import the address book data that had been exported 
as CSV files from this equipment (e-STUDIO165/205, e-STUDIO167/207/237, or 
e-STUDIO182/212/242), e-STUDIO850 Series, e-STUDIO282 Series, e-STUDIO452 
Series, e-STUDIO451C Series, e-STUDIO3510C Series, e-STUDIO4520C Series, 
e-STUDIO6530C Series, e-STUDIO455 Series, e-STUDIO855 Series address book 
using the AddressBook Viewer. The data will be imported in the "Import Address Book".

- Import -vCard File — Select this to import the address book data that had been 
exported as vCard files from this equipment (e-STUDIO165/205, e-STUDIO167/207/237, 
or e-STUDIO182/212/242), e-STUDIO850 Series, e-STUDIO282 Series, e-STUDIO452 
Series, e-STUDIO451C Series, e-STUDIO3510C Series, e-STUDIO4520C Series, 
e-STUDIO6530C Series, e-STUDIO455 Series, e-STUDIO855 Series address book 
using the AddressBook Viewer. The data will be imported in the "Import Address Book". 
This command is available only when Microsoft Office XP is installed on your computer.

- Export - CSV File — Select this to export the selected address book as a CSV file.
- Export - vCard File — Select this to export the selected address book as a vCard file. 

This command is available only when Microsoft Office XP is installed on your computer.
- Exit — Select this to exit the AddressBook Viewer.

2) Edit menu
The following commands can be selected in the Edit menu.
- Copy — Select this to copy the selected contacts or a group in the clipboard. The con-

tacts or a group copied in the clipboard can be pasted in the private address book. This 
item is available only when selecting a group or contacts in any address book.

- Paste — Select this to paste the contacts or a group copied in the clipboard in the private 
address book. If the group has been copied, this item is available only when selecting the 
“Group” folder. If the contacts have been copied, this item is available only when select-
ing a group or the “Location/People” folder in the private address book.

- Select All — Select this to select all contacts displayed in the right pane. This item is 
available only when browsing groups or contacts.

- Find — Select this to find a contact by searching the address book. You can also search 
the LDAP server to add the contacts in the LDAP address book.

3) View menu
The following commands can be selected in the View menu.
- Toolbar — Select this to display or hide the toolbar. When the check mark appears in the 

menu, the toolbar is currently displayed. You can select it again to hide the toolbar.
- Status Bar — Select this to display or hide the status bar. When the check mark appears 

in the menu, the status bar is currently displayed. You can select it again to hide the sta-
tus bar.

- Large Icons — Select this to display the contacts using large icons.
- Small Icons — Select this to display the contacts using small icons.
- List — Select this to display the contacts in a list.
- Details — Select this to display the contacts in a list with detailed information.
- Sort By -Display Name — Select this to sort the contacts alphabetically by the name.
- Sort By - Fax Number — Select this to sort the contacts alphabetically by the fax num-

ber.
- Sort By - Email Address — Select this to sort the contacts alphabetically by the Email 

address.
- Sort By - Ascending — Select this to sort the contacts alphabetically in ascending order.
- Sort By - Descending — Select this to sort the contacts alphabetically in descending 

order.
- Default Configuration - Data Source — Select the address book that will be the default 

address book for the Find Contact dialog box. Select the address book from which you 
frequently search for the contacts. The public address book is set as the factory default.
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- Default Configuration - Type Selection — Select the default destination type that will 
be enabled in the Type Selection dialog box, which appears when searching for the con-
tacts as the destinations of the network fax job. You can select either “Fax Number”, 
“Email Address” or “Both” to set the default selection type. The “Fax Number” is set as 
the factory default. This can be set only when the AddressBook Viewer is launched from 
the N/W-Fax driver.
In this equipment, the type other than "Fax Number" cannot be selected.

4) Tools menu
The following commands can be selected in the Tools menu.
- LDAP Setting — Select this to configure the LDAP service to obtain the LDAP address 

book from the LDAP server.
- Device Setting — Select this to find the device to obtain the public address book from 

this equipment.
- Convert for TopAccess — Select this to convert the file format of the address book file 

created by the backup or export function in TopAccess to the one for restoring or import-
ing the address book data in the address book in the following models. This menu is 
available only when Windows 2000, Windows XP, Windows Vista, Windows Server 2003 
or Windows Server 2008 is used.
This equipment (e-STUDIO165/205, e-STUDIO167/207/237, or e-STUDIO182/212/242), 
e-STUDIO850 Series, e-STUDIO282 Series, e-STUDIO452 Series, e-STUDIO451C 
Series, e-STUDIO3510C Series, e-STUDIO4520C Series, e-STUDIO6530C Series, 
e-STUDIO455 Series, e-STUDIO855 Series

To use “Convert for TopAccess”, Java 2 Runtime Environment V1.4.2 or later must be 
installed.
The Address Book Converter is displayed only when an OS with a 32-bit version is used.

5) Help
The following commands can be selected in the Help menu.
- Contents and Index — Select this to display the Online Help.
- About TOSHIBA e-STUDIO AddressBook Viewer — Select this to display the version 

information.

Toolbar
You can use the following tool icon to perform various functions quickly:

 (New Contact) — Click this to add a new contact in the private address book. If the cur-
rently selected item is a group, the contact will be created as a member of the group. If the cur-
rently selected item is a contact or the address book, the contact will be created in the address 
book. This icon is available only when selecting items in the private address book.

 (New Group) — Click this to add a new group in the private address book. This icon is 
available only when selecting the “Group” folder in the private address book.

 (Copy) — Click this to copy the selected contacts or a group in the clipboard. The contacts 
or a group copied in the clipboard can be pasted in the private address book. This icon is avail-
able only when selecting a group or contacts in any address book.

 (Paste) — Click this to paste the contacts or a group copied in the clipboard in the private 
address book. If the group has been copied, this item is available only when selecting a “Group” 
folder. If contacts have been copied, this item is available only when selecting a group or "Loca-
tion/People" folder in the private address book.
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 (Properties) — Click this to edit or display the properties of a group or a contact. This icon 
is available only when selecting a group or a contact.

 (Delete) — Click this to delete a group or contacts in the private address book. This icon is 
available only when selecting a group or contacts in the private address book.

 (Find) — Click this to find a contact by searching the address book.

 (Download AB) — Click this to download the public address book that you modified to this 
equipment. 

Context-sensitive menus
You can also use the context-sensitive menu that is displayed by right-click the an item dis-
played in AddressBook Viewer window.

Add - Contact — Select this to add a new contact in the private address book. If the cur-
rently selected item is a group, the contact will be created as a member of the group. If the 
currently selected item is the "Location/People" or the private address book folder, the con-
tact will be created in the "Location/People" folder. This command is available only when 
selecting items in the private address book.
Add - Group — Select this to add a new group in the private address book. This command 
is available only when selecting the “Group” folder in the private address book.
Copy — Select this to copy the selected contacts or groups in the clipboard. The contacts or 
groups copied in the clipboard can be pasted in the private address book. This item is avail-
able only when selecting contacts or groups in any address book.
Paste — Select this to paste the contacts or groups copied in the clipboard in the private 
address book. This item is available only when selecting a group or the “Location/People” 
folder in the private address book.
Properties — Select this to edit or display the properties of a contact or group. This com-
mand is available only when selecting a contact or group.
Delete — Select this to delete the selected contacts or groups in the private address book. 
This command is available only when selecting contacts or groups in the private address 
book.
Select - Fax Number — Select this to add the fax numbers of selected contacts or groups 
as destinations to be sent using the N/W-Fax driver. (This item is available only when 
accessing the AddressBook Viewer from the N/W-Fax driver properties dialog box and 
selecting contacts or groups.)
Select - E-Mail — Select this to add the Email addresses of selected contacts or groups as 
destinations to be sent using the N/W-Fax driver. (This item is available only when accessing 
the AddressBook Viewer from the N/W-Fax driver properties dialog box and selecting con-
tacts or groups.) (This function is not available in the equipment.)
Export to vCard — Select this to export the selected contact as a vCard file. This command 
is available only when Microsoft Office XP is installed on your computer.
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Managing Address Book

You can use the AddressBook Viewer to manage the private address book. You can add or edit 
the contacts and groups as you desire. The private address book data is stored in your client 
computer. It can be used to manage the contacts and groups for sending a fax using the N/W-
Fax driver.
The AddressBook Viewer also displays a public address book that is the address book in the 
compatible TOSHIBA equipment, such as this equipment (e-STUDIO165/205, e-STUDIO167/
207/237, or e-STUDIO182/212/242), e-STUDIO850 Series, e-STUDIO282 Series, 
e-STUDIO452 Series, e-STUDIO451C Series, e-STUDIO3510C Series, e-STUDIO4520C 
Series, e-STUDIO6530C Series, e-STUDIO455 Series, e-STUDIO855 Series. Using the 
AddressBook Viewer, you can display the contacts or groups in the address book and they can 
be copied to your private address book.
In addition, you can access additional address book data such as the address book application 
of the default Email client in your computer, Microsoft Outlook address book, and an LDAP 
directory service running in your network. You cannot add, delete, or edit the data in these 
address book, but you can copy their address book data to paste into the private address book.

About the address books
You can manage your address book using the following address books:

Private address book can be used as your own address book.
 P.66 “Managing the private address book”

Public address book allows you to display the address book in this equipment 
(e-STUDIO165/205, e-STUDIO167/207/237 or e-STUDIO182/212/242) or other TOSHIBA 
MFPs.

 P.66 “Managing the public address book”
MAPI address book allows you to display the address book data of the default Email applica-
tion in your computer.

 P.73 “Configuring the MAPI address book”
MS Outlook address book allows you to display the address book data of Microsoft Outlook 
Express in your computer. The name of this address book may differ depending on the Email 
software of Microsoft in your computer.

 P.73 “Managing the Microsoft Outlook address book”
LDAP address book allows you to display the address book data which is added from LDAP 
servers.

 P.73 “Managing the LDAP address book”

Also the AddressBook Viewer allows users to import and export the address book data as CSV 
file or vCard file, so that users can import the CSV file or vCard file which exported from another 
user’s private address book or public address book, and users can export the private address 
book and public address book for other users.

 P.81 “Importing and exporting the address book”

Importing and exporting a vCard file is available only when Microsoft Office XP is installed on 
your computer.
The command for importing or exporting address book data as a vCard file appears only 
when a vCard file can be used on your computer.
When you import or export a vCard file, only a single contact can be imported or exported.
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Managing the private address book
You can manage your own address book using the private address book. You can add, delete, 
and modify the contacts in this address book. You can also create, delete, and modify groups.
Contacts and groups can be added to this address book by various ways using other address 
books within the AddressBook Viewer. For instruction on how to manage the contacts and 
groups in the private address book, please refer to the following section:

 P.85 “Managing contacts and groups”

Managing the public address book
In order to access the public address book in this equipment (e-STUDIO165/205, 
e-STUDIO167/207/237 or e-STUDIO182/212/242) or other TOSHIBA MFPs, you must configure 
the connection to the target MFP correctly.
You can configure the connection by searching the network for the device, or entering the IP 
address of the device manually.

 P.66 “Configuring the connection by local discovery”
 P.69 “Configuring the connection by manual selection”

After configuring the connection to the device, the address book data of the device is obtained in 
the public address book. You can display the address book data and copy them in the private 
address book.
For the instruction to download the public address book data into the AddressBook Viewer, 
please refer to the following section:

 P.72 “Downloading the public address book”

The address book in this equipment cannot be acquired using AddressBook Viewer with the 
USB connected.

— Configuring the connection by local discovery
You can search your network for the device and configure the connection.
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Discovering the device and obtaining the public address book data

1 Select “Public Address Book” in the browse pane, click the [Tools] 
menu, and select [Device Setting].

The Local Discovery dialog box appears.

2 Click [Start Discovery] to begin the process.

It locates all the compatible devices in your network.

You can quit the process by clicking [Stop Discovery].
When this equipment is on another segment, it may not be discovered. In this case, 
click [Manual Selection] to discover the equipment manually.

 P.69 “Configuring the connection by manual selection”
If the process continues for a long time, it is because the too many network clients are 
in the network. In this case, you can configure the discovery settings from [Advanced] 
button.

 P.68 “Configuring discovery settings”

3 When the process completes, found printers are listed in the list.
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4 Select the device that you want to access from the list and click 
[OK].

You can obtain the address book data by clicking Public Address Book in the browse 
pane.

Configuring discovery settings
You can configure the discovery settings.

1) Devices
Click the arrow button to display the pull down list and check the model name that you want 
to search. When searching for this equipment, select “Find e-STUDIO205 Series”.

2) Network - Enable IPX/SPX Search
This is disabled because the AddressBook Viewer does not support the IPX/SPX connec-
tion.
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3) Network - Enable TCP/IP Search
Check on this to search devices that connect to the TCP/IP network. This is available only 
when the TCP/IP protocol is installed in your computer.
When this is enabled, select how it searches printers in the TCP/IP network.
- Search local subnet — Select this to search devices in local subnet.
- Specify a range — Select this to specify a range of IP addresses to search devices. In 

this case check “IPv4” and enter the desired range of IP addresses in the “From” and “To” 
fields. “IPv6” is unavailable.

This equipment does not support [SNMP Settings].

— Configuring the connection by manual selection
You can configure the connection by entering the IP or IPX address of the device manually.

Configuring the connection manually and obtaining the address book data

1 Select “Public Address Book” in the browse pane, click the [Tools] 
menu, and select [Device Setting].

The Local Discovery dialog box appears.
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2 Click [Manual Selection].

The Manual Selection dialog box appears.

3 Enter each item to specify the printer address and click [OK].

IPv4 - IP Address — Enter the IP address of the printer.
IPv6 - IP Address — This is disabled because the AddressBook Viewer does not 
support the IPv6.
IPX Address — This is disabled because the AddressBook Viewer does not support the 
IPX/SPX connection.
Name — Enter the printer name.
Location — Enter the location of the printer.

You must enter “Name” and “IP Address”. 
This equipment does not support [SNMP Settings].
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4 Select the entered device name and click [OK].

You can obtain the address book data by clicking Public Address Book in the browse 
pane.
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— Downloading the public address book
You can download the address book data in the equipment to the AddressBook Viewer.

Only the administrator can back up the address book data. If the address book data are old, ask 
your administrator to back up the address book data.

Downloading the public address book data

1 Click the [File] menu, select [Devices], and select the TOSHIBA MFP 
that you want to download the address book.

2 Select “Public Address Book” in the browse pane.

3 The Downloading dialog box appears. You can quit downloading 
the address book data by clicking [Cancel].

The public address book data is downloaded from the selected TOSHIBA MFP.
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Configuring the MAPI address book
The AddressBook Viewer automatically accesses the address book application of the default 
Email client software using the Messaging API (MAPI).
If the AddressBook Viewer prompts an error message when selecting the MAPI address book, 
the default Email client software has not been defined in your computer, or the default Email 
software does not support MAPI. In this case, set the MAPI-compliant Email software as the 
default Email client. For instructions on how to set your Email application as default Email client, 
refer to the documentation or online help of your Email application.
You can use the MAPI address book to copy the contacts and groups to the private address 
book.
When Microsoft Outlook is used as an Email client, turn OFF the cache exchange mode before 
obtaining the MAPI address.

 P.89 “Copying contacts from an address book”

The MAPI Address Book cannot be used on Windows 2000 x64 or Windows XP x64.

Managing the Microsoft Outlook address book
The AddressBook Viewer automatically accesses the Microsoft Outlook Express address book 
to obtain the address book data. You use the MS Outlook address book to copy the contacts and 
groups to the private address book. The name of this address book may differ depending on the 
Email software of Microsoft in your computer.

 P.89 “Copying contacts from an address book”

Managing the LDAP address book
In order to access to the address book data in the LDAP servers, first you must register the 
LDAP directory services that you want to access.

 P.74 “Registering the LDAP directory services”
Then search contacts in the LDAP server and add the contacts to the LDAP address book.

 P.76 “Adding contacts from LDAP servers”
You can use the LDAP address book to copy the contacts to the private address book.

 P.89 “Copying contacts from an address book”
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— Registering the LDAP directory services
You can register multiple LDAP directory services.

Registering the LDAP directory services

1 Click the [Tools] menu and select [LDAP Setting].

The Internet Account dialog box appears.

2 In the General tab, enter the items as described below.

Directory Server Name — Enter the server name or IP address of a LDAP server.
This Server requires me to log on — Check this if the LDAP server requires the user 
name and password to log on.
Account Name — Enter the user name to log on the LDAP server.
Password — Enter the password to log on the LDAP server.
Log on using Secure Password Authentication — Check this to use secure password 
to log on the LDAP server.
Character code setting — Select the character code for the LDAP server.

In the Directory Server Name field, enter the IP address instead of the server name if the 
LDAP server name cannot be resolved.
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3 In the Advanced tab, enter the items as described below.

Server Port Number - Directory service (LDAP) — Enter the port number to access 
the LDAP server. It shows “389” as a default. Change this number if you are sure the 
LDAP port number is changed from the default port number on the LDAP server.
Server Port Number - This Server requires a secure connection (SSL) — Check this 
when you require to access the LDAP server using SSL.
Search - Search timeout — Select the time-out interval for searching.
Search - Maximum number of matches to return — Select maximum numbers for the 
search results.
Search - Search Base — Enter the search root suffix.

4 Click [Add].
The entered directory service is added to the Directory Service list.

5 Repeat the procedure from Step 2 to Step 4 until all required direc-
tory services are added.

6 Click [Close].
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— Adding contacts from LDAP servers
After you register the LDAP directory services, you can search contacts in the LDAP servers and 
add preferred contacts to the LDAP address book.
You can search contacts by the name and fax number. Also you can search contacts by specify-
ing the detailed search conditions.

Searching contacts by name, fax number, and e-mail address

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select a registered directory service in the “Data Source” drop 
down box.
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3 Display the Person tab and enter search text in the following fields 
that you require.

Name — Enter the search characters or string to search by the contact name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact Email address. 
Email addresses cannot be specified for the address in this equipment.

You must enter data into one of the fields to search contacts. It will search the contacts 
that contain the entered search strings.

If you want to clear entered values, click [Clear All].

4 Click [Search].
It begins searching contacts in the LDAP server. When it completes searching, found 
contacts appears in the list at the bottom of the dialog box.

If you want to stop searching, click [Stop].
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5 Select contacts that you want to add to the LDAP address book. 
Then click the [Add] and click [Close].

The selected contacts are added to the LDAP address book.

Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select a registered directory service in the “Data Source” drop 
down box.
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3 Display the Detail Setting tab and select a field to search in the 
“Field Select” drop down box.

4 Select how it searches contacts in the “Condition of search string” 
drop down box.

Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

5 Enter the search string in the next field to the “Condition of search 
string” drop down box.

6 Click [Add].
Specified search condition is added to the condition list.

If you want to clear entered values, click [Clear All].

7 Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions.

You can remove the search conditions you have added. To do this, select the condition 
and click [Delete].
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8 Click [Search].

It begins searching contacts in the LDAP server. When it completes searching, found 
contacts appear in the list at the bottom of the dialog box.

If you want to stop searching, click [Stop].

9 Select contacts that you want to add to the LDAP address book. 
Then click the [Add] and click [Close].

The selected contacts are added to the LDAP address book.



Managing Address Book    81

Importing and exporting the address book
The Export feature of the AddressBook Viewer allows you to create a CSV file or vCard file of 
your selected address book, and it can be imported to other user’s AddressBook Viewer. The 
Import/Export feature is useful when users want to share the address book data.

The CSV file to import the AddressBook Viewer must be created as the comma separated 
file in the following format:

For more information about the format, please contact your service representative.
Importing and Exporting a vCard file is available only when Microsoft Office XP is installed on 
your computer.
When you import or export a vCard file, only a single contact can be imported or exported.

If any data is lost during importing, confirm the following:
Both the First Name and Last Name are not blank.
Both the Email address and Fax number are not blank.

Also you can use the import address book to copy the contacts and groups to the private 
address book.

 P.89 “Copying contacts from an address book”

Group Name,Contact Key,Prefix,First Name,Last Name,Suffix,Display Name,Company Name,Department Name,First Fax 
Number,Second Fax Number,Email Address,Furigana,One Touch ID,Notes,Attenuation,Error Correction Mode,Fax Mode,Line 
Monitor,Line Selection,Option Type,Oversea Calls,Print Transmission Report,Short Protocol,Transmission 
Type,UseDeviceSettings,UseSubAddSID,Compression,PageWidth,Resolution,Password,SenderIdentification,SEP,SubAddress
,1,,User01,User,,User01 User,12345COMPANY,Dept01,00000000001,,user01@ifax.com,,1,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,,
,2,,User02,User,,User02 User,12345COMPANY,Dept02,00000000002,,user02@ifax.com,,2,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,,
Group1,1,1,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
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Importing the address book from a CSV file or vCard file

1 Click the [File] menu and select [Import] and [CSV File] or [vCard 
File].

The Importing dialog box appears.

The [vCard File] command will appear only when Microsoft Office XP is installed on 
your computer.
Even if you import a vCard file that contains multiple contacts, only a single contact 
can be imported.

2 Locate the folder where the CSV file or vCard file is stored, and 
select the file type in the “Files of type” drop down box. Then select 
the file and click [Open].
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3 The address book data is imported into “Import Address Book”.

If you have already been import an address book before, contacts information is 
overwritten to the existing import address book.

If one or more records have been skipped during the import process, it may be due to 
one of the following reasons:

Record already exists.
Group name contains an invalid character.
Fax number is invalid.
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Exporting the address book as a CSV file or vCard file

1 Click the [File] menu and select [Export] and [CSV File] or [vCard 
File].

The Exporting dialog box appears.

The [vCard File] command will appear only when Microsoft Office XP is installed on 
your computer.
The [vCard File] command can be selected only when you select an individual con-
tact. Only a single contact can be exported.

2 Locate the folder where you want to save the CSV file or vCard file, 
and select the file type in the “Save as type” drop down box. Then 
enter the file name and click [Save].

The private address book is exported as a CSV file or vCard file.
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Managing contacts and groups
You can manage contacts or groups in a private address book.
The private address book allows you to register up to 2000 contacts into its “Location/People” 
folder and sort them into some groups arbitrarily created. You can create up to 200 groups and 
you can register up to 400 contacts in one group.

Managing contacts
You can add contacts to the “Location/People” folder and each created groups in the private 
address book.
There are several ways to add the contact to the container.

 P.85 “Adding contacts manually”
 P.89 “Copying contacts from an address book”

Also you can modify or delete contacts in the private address book.
 P.90 “Displaying or modifying contacts properties”
 P.94 “Removing contacts”

— Adding contacts manually
You can add new contacts to the “Location/People” folder in the private address book. Also you 
can add new contacts to groups created in the private address book.

Adding a new contact manually

1 Select the folder that you want to add new contact in the left pane.

If you want to add new individual contact in the private address book, select the 
“Location/People” folder under “Private Address Book” folder.
If you want to add new contact to the group in the private address book, select a 
group that you want to add a contact in the “Group” folder under “Private Address 
Book” folder.
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2 Click the [File] menu and select [New Contact].

The New Contact dialog box appears.
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3 In the Personal tab, enter items as described below.

One Touch ID — Select the one touch ID number for the contact (if desired).
Prefix — Select the prefix for the contact.
First Name — Enter the first name of the contact. You can enter up to 32 characters.
Last Name — Enter the last name of the contact. You can enter up to 32 characters.
Suffix — Select the suffix for the contact.
Display Name — The display name is automatically entered as “[Prefix] [First Name] 
[Last Name] [Suffix]”. You can also edit the name as you prefer. You can enter up to 80 
characters.
Company — Enter the company name of the contact. You can enter up to 64 characters.
Department — Enter the department name of the contact. You can enter up to 64 
characters.
Fax — Enter the 1st fax number of the contact. You can enter up to 128 characters 
includes numbers and the following symbols: +, -, *, #
To add a 3 second pause to a fax telephone number, place a hyphen (-) at the desired 
point in the number.
Second Fax — Enter the 2nd fax number of the contact. You can enter up to 128 
characters includes numbers and the following symbols: +, -, *, #
To add a 3 second pause to a fax telephone number, place a hyphen (-) at the desired 
point in the number.
E-Mail Address — Enter the Email address of the contact. You can enter up to 192 
characters. Email addresses cannot be specified for the address in this equipment.
Notes — Enter any notes for the contact. You can enter up to 256 characters.

You must enter either “First Name” or “Last Name”, and either “Fax” or “E-Mail Address”.
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4 In the Sending Options tab, enter items as described below as 
required.

Use Sub Address and sender information — Check this to enable sub address 
transmission for this contact. When this is checked, documents will be always sent using 
the specified sub address and SID. Also you can use this contact to perform polling 
transmission from the mailbox in the remote facsimile using the specified sub address 
and password.
Sub Address — Enter the sub address or mailbox number of remote facsimile where a 
document will be sent. This can be entered only when “Use Sub Address and sender 
information” is enabled.
Sender Identification — Enter the security password for the sub address if required. 
This can be entered only when “Use Sub Address and sender information” is enabled.

Other items in this tab cannot be modified.

5 Click [OK].
The contact is added to the list in the selected folder.
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— Copying contacts from an address book
You can also add contacts to the private address book by copying contacts from another 
address book folder.

Copying contacts from another address book folder

1 Browse to the folder that contains the contacts you want to copy, 
and select the contacts in the right pane.

2 Click the [Edit] menu and select [Copy].

The selected contacts are copied in the clipboard.

3 Browse the Private Address Book and select a folder that you want 
to add the copied contacts in the left pane.

If you want to copy individual contacts in the private address book, select the “Loca-
tion/People” folder under the “Private Address Book” folder.
If you want to copy contacts to the group in the private address book, select a group 
that you want to add contacts in the “Group” folder under the “Private Address Book” 
folder.

4 Click the [Edit] menu and select [Paste].

Copied contacts are added to the list in the selected folder.
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— Displaying or modifying contacts properties
You can display the properties of contacts in any address book. You can also edit the properties 
of contacts in the private address book.

Displaying or modifying the contact properties

1 Browse to the folder that contains the contacts you want to display 
or modify, and select the contact in the right pane.

2 Click the [File] menu and select [Properties].

The Properties dialog box appears.

You can also display the Properties dialog box by double-clicking the contact in the right 
pane.

In the Properties dialog box, you can modify the settings of the contacts in the private 
address book only. When you display the Contact dialog box of the contacts in any other 
address books, you cannot modify the settings.
The Properties dialog box contains the Personal tab, Sending Options tab, and Security 
tab.

The tabs that will be displayed vary based on the type of the address book that the con-
tact is chosen from.
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Personal tab
In the Personal tab, the following items are displayed:

When displaying the properties of a contact in the private address book, you can modify all 
items.

One Touch ID — Select the one touch ID number for the contact.
Prefix — Display the prefix for the contact.
First Name — Display the first name of the contact.
Last Name — Display the last name of the contact.
Suffix — Display the suffix for the contact.
Display Name — Display the display name of the contact.
Company — Display the company name of the contact.
Department — Display the department name of the contact.
Fax — Display the 1st fax number of the contact.
Second Fax — Display the 2nd fax number of the contact.
E-Mail Address — Display the Email address of the contact. Email addresses cannot be 
specified for the address in this equipment.
Notes — Display the notes for the contact.
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Sending Options tab
In the Sending Options tab, the following items are displayed:

When displaying the properties of a contact in the private address book, you can modify the fol-
lowing settings:
- Use Sub Address and sender information
- Sub Address
- Sender Identification
Items other than the above cannot be set.

Use Device Settings — This is checked when the contact is set to use the device settings 
rather than using the settings on this tab.
Use Sub Address and sender information — This is checked when the sub address trans-
mission for this contact is enabled. When this is checked, a document will be always sent 
using the specified sub address and SID. Also you can use this contact to perform polling 
transmission from the mailbox in the remote facsimile using the specified sub address and 
password.
Sub Address — Display the sub address or mailbox number of remote facsimile where a 
document will be sent.
Sender Identification — Display the security password for the sub address if required.
Selective Polling — Display the mailbox number of remote facsimile where a document will 
be retrieved.
Password — Display the password for the selective polling if required.
Overseas Calls — This is checked when calling the contact fax number will be oversea call.
Error Correction Mode — This is checked when the ECM for this contact is enabled.
Print Transmission Report — This is checked when printing the transmission report after 
the transmission is enabled.
Reduction — This is checked when the attenuation is enabled.
Short Protocol — This is checked when the short protocol is enabled.
Line Monitor — This is checked when the Line Monitor for the fax transmission is enabled.
Line Selection — Display whether the line 1 or line 2 is used for the fax transmission. The 
line 2 can be selected only when optional Line 2 board is installed.
Transmission Type — Display whether the memory transmission or direct transmission is 
used for the transmission.
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Internet Fax Mode — Display whether the simple mode or full mode is used for the Internet 
Fax transmission. (Email reception is not available in the equipment.)
Setting Value — Display whether to use auto detect receiver capability or manual settings 
for the Internet Fax transmission. When “Default” is selected, it enable auto detect receiver 
capability for the Internet Fax transmission. When “Custom” is selected, it uses custom set-
tings specified in the “Receiver Capability” option for the Internet Fax transmission. (Email 
reception is not available in the equipment.)
Receiver Capability — Display the receiver capabilities settings, such as resolution, com-
pression, and page width. These are applied to the transmissions only when “Custom” is 
selected in the “Setting Value” option.

Security tab
In the Security tab, the following items are displayed:

Whether this tab appears or not depends on the address book being used.

Owner — Display the owner name of this contact.
Password — Display the password of this contact.
Editing Date — Display the date that this contact is created.
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— Removing contacts
You can remove contacts from the private address book and LDAP address book.

Removing contacts from address book

1 Browse the folder that contains contacts you want to remove, and 
select contacts in the right pane.

2 Click the [File] menu and select [Delete].

The Confirmation Deletion dialog box appears.

3 Click [Yes].

The selected contacts are deleted.
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Managing groups
You can add groups to the “Group” folder in the private address book. Groups can be used for 
multiple transmission.

 P.95 “Creating groups”
Also you can modify or delete contacts in the private address book.

 P.97 “Modifying group name”
 P.98 “Removing groups”

After you create a group, you can add or delete contacts in the group. For the instruction to add 
contacts in a group, please refer to the following section.

 P.85 “Managing contacts”

— Creating groups
You can create groups in the “Group” folder in the private address book.

Creating groups

1 Select the “Group” folder in the “Private Address Book” folder.

2 Click the [File] menu and select [New Group].

The Group dialog box appears.
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3 Enter a group name in the “Group Name” field.

The “Group ID” field displays the Group ID number automatically detected.

4 Click [OK].
The group is created in the selected “Group” folder.

5 Continue to add contacts to the group.
 P.85 “Managing contacts”
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— Modifying group name
You can change the group name of the groups in the private address book. You can also display 
the properties of a group in the public address book.

You cannot modify the group of the public address book.

Modifying the group name

1 Select the group that you want to display or modify the group prop-
erties in the “Group” folder either of the private address book and 
public address book.

2 Click the [File] menu and select [Properties].

The Group dialog box appears.

3 When you display the properties of the group in the private address 
book, modify the group name in the “Group Name” field and click 
[OK].

The group name of selected group is modified.
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— Removing groups
You can delete groups in the private address book.

When you delete a group, contacts added in the group are also deleted.

Removing a group

1 Select the group that you want to delete in the “Group” folder of the 
private address book.

2 Click the [File] menu and select [Delete].

The Confirm Deletion dialog box appears.

3 Click [Yes].

The selected group is deleted.
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Searching contacts
In order to quickly locate contacts you can search the address book database. You simply type 
in a string or letters to be used to search the database. The AddressBook Viewer will search for 
any entry that contains the specified string.
You can search contacts by the name and fax number. Also you can search contacts by specify-
ing the detailed search conditions.

If the AddressBook Viewer is launched by clicking [Select From Address Book] in the N/W-Fax 
driver, you can add the searched contacts as recipients for N/W-Fax.

Searching contacts by name and fax number

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select an address book to search contacts in the “Data Source” 
drop down box.

The default address book in the “Data Source” can be set by selecting [View] - [Default 
Configuration] - [Data Source] from the menu bar.
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3 Display the Person tab and enter search text in the following fields 
that you require.

Display Name — Enter the search characters or string to search by the first name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact Email address. 
Email addresses cannot be specified for the address in this equipment. 

You must enter one of the field to search contacts. It will search the contacts that have 
exactly same name or fax number as the entered search strings.

If you want to clear entered values, click [Clear All].

4 Click [Search].
It begins searching contacts in the selected address book. When it completes search-
ing, found contacts appear in the list at the bottom of the dialog box.
If the AddressBook Viewer is launched by clicking [Select From Address Book] in the 
N/W-Fax driver, you can add the searched contacts as recipients for N/W-Fax.

 P.103 “Adding contacts as recipients for N/W-Fax”

If you want to stop searching, click [Stop].
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Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select an address book to search contacts in the “Data Source” 
drop down box.

The default address book in the “Data Source” can be set by selecting [View] - [Default 
Configuration] - [Data Source] from the menu bar.

3 Display the Detail Setting tab and select a field to search in the 
“Field Select” drop down box.
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4 Select how it searches contacts in the “Condition of search string” 
drop down box.

Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

5 Enter the search string in the next field to the “Condition of search 
string” drop down box.

6 Click [Add].
Specified search condition is added to the condition list.

If you want to clear entered values, click [Clear All].

7 Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions.

You can remove the search conditions you have added. To do this, select the condition 
and click [Delete].
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8 Click [Search].

It begins searching contacts in the selected address book. When it completes search-
ing, found contacts appear in the list at the bottom of the dialog box.
If the AddressBook Viewer is launched by clicking [Select From Address Book] in the 
N/W-Fax driver, you can add the searched contacts as recipients for N/W-Fax.

 P.103 “Adding contacts as recipients for N/W-Fax”

If you want to stop searching, click [Stop].

Adding contacts as recipients for N/W-Fax

If the AddressBook Viewer is launched by clicking [Select From Address Book] in the N/W-Fax 
driver, you can add the searched contacts as recipients for N/W-Fax.

 P.41 “Searching the address book for contacts”
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Converting the address book data
The address book data conversion function allows you to convert the address book data into a 
file format which can be used in this equipment.

Address book converter file (*.abc) to TBF file (*.tbf)
The address book converter allows you to convert the address book data files in the address 
book converter file format (*.abc), which have been created using the backup functions into a 
TBF format. You can register the address book data into this equipment by restoring these 
TBF files. For the restoring procedure, see the following page:

 P.104 “Converting from an address book converter file”
CSV files (*.csv) to CSV files (*.csv)
You can convert the address book data in a CSV format, which have been created in other 
TOSHIBA MFPs into another CSV format which can be exported to this equipment.

 P.107 “Converting from a CSV file”

The Address Book Converter can be used with the 32-bit editions of Windows 2000, Win-
dows XP, Windows Vista, Windows Server 2003 and Windows Server 2008.
To use the Address Book Converter, Java 2 Runtime Environment V1.4.2 must be installed.

Converting from an address book converter file

1 Click the [Tools] menu and select [Convert for TopAccess].

The Converting AddressBook dialog box appears.

2 Click [Browse] at the next of the “Input file” field.
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3 Locate the folder that contains the address book converter file 
(*.abc). Select “ABC (Address Book Converter) (*.abc)” in the “Files 
of type” drop down box, select the file, and click [Open].

4 Select the model name that the selected file is originally created 
from in the “Machine Type” drop down box.

5 Click [Browse] at the next of the “Output File” field.
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6 Locate the folder where you want to save a converted file. Select 
“TBF (Restore) (*.tbf)” in the “Save as type” drop down box, enter 
the file name in the “File name” field, and click [Save].

When you selected an Address Book Converter file for the input file, do not specify “CSV 
(Comma Separated Values) (*.csv)” in the “Save as type” drop down box. The Address 
Book Converter file cannot convert to a CSV file.

7 Click [Convert].

It starts converting a file.

8 Click [OK].

The file is converted and saved in the selected folder.

After you convert the file, you can restore or import the address book into the equipment 
using the restore or import function of the TopAccess. For instructions on how to restore 
or import the address book, refer to the Setup Guide for Printing Functions.
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Converting from a CSV file

1 Click the [Tools] menu and select [Convert for TopAccess].

The Converting AddressBook dialog box appears.

2 Click [Browse] at the next of the “Input file” field.

3 Locate the folder that contains the CSV file. Select “CSV (Comma 
Separated Values) (*.csv)” in the “Files of type” drop down box, 
select the file, and click [Open].
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4 Select the model name that the selected file is originally created 
from in the “Machine Type” drop down box.

5 Click [Browse] at the next of the “Output File” field.

6 Locate the folder where you want to save a converted file. Select 
“CSV (Comma Separated Values) (*.csv)” in the “Save as type” drop 
down box, enter the file name in the “File name” field, and click 
[Save].

When you selected a CSV file for the input file, do not specify “TBF (Restore) (*.tbf)” in 
the “Save as type” drop down box. The CSV file cannot convert to a Restore file.
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7 Click [Convert].

It starts converting a file.

8 Click [OK].

The file is converted and saved in the selected folder.

After you convert the file, you can restore or import the address book into the equipment 
using the restore or import function of the TopAccess. For instructions on how to restore 
or import the address book, refer to the Setup Guide for Printing Functions.
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Cover Sheet Samples

Standard cover page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Business cover page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Professional cover page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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